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SAP Identity Management

About the Tutonial

SAP IdM is an identity management system to perform the user management and business
workflows in large and complex enterprise. You can integrate SAP and non-SAP systems
to identity management using default packages to import identity data and to provide self-
service access management feature to end users.

Audience

This tutorial has been prepared for someone who wants to learn and understand the
processes in Identity management. After completing this tutorial, you will find yourself at
a moderate level of expertise in SAP IdM.

Prerequisites

Before you start proceeding with this tutorial, we assume that you are well-versed with
basic access management concepts. You should have basic knowledge on how an Identity
and Access management system works.

Copyright & Disclaimer

© Copyright 2021 by Tutorials Point (I) Pvt. Ltd.

All the content and graphics published in this e-book are the property of Tutorials Point (I)
Pvt. Ltd. The user of this e-book is prohibited to reuse, retain, copy, distribute or republish
any contents or a part of contents of this e-book in any manner without written consent
of the publisher.

We strive to update the contents of our website and tutorials as timely and as precisely as
possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt.
Ltd. provides no guarantee regarding the accuracy, timeliness or completeness of our
website or its contents including this tutorial. If you discover any errors on our website or
in this tutorial, please notify us at contact@tutorialspoint.com
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1. SAP IDM — Introduction

In large enterprises, main challenge is to organize and maintain identity data and privilege
securely. Enterprise data is stored in different applications and collected from multiple
source so it includes major risk to manage the data confidentiality. To distribute the data
security, there is need to manage and maintain identity data and privileges up to date.
There are various Identity and access management modules in market which helps Data
owner in managing identity information accurately and up to date.

Major ERP software providers provide inbuild capability to manage identity with other
modules. These identity management tools are embedded in ERP/CRM software and no
need to install or configure explicitly.

SAP Identity Management is similar tool provided by SAP which help companies managing
their user accounts in complex environment for both SAP and non-SAP systems. With use
of SAP Identity management tool, companies can manage and provide access to different
heterogenous applications without much manual work and that too securely.

There are various reasons why an Identity and Access Management soln is required:

e As business processes running on on-premise and cloud both there is need to
manage user access management seamlessly.

e Need to assign application and information access based on user roles and
irrespective of technical hierarchies in directory

e To provide self-service user and password management system and to avoid
manual password reset for critical applications

e To pull the reports based on current and previous access

¢ Reduce the operational cost to perform user provisioning in complex landscape
e Ease to manage multiple source of identities

e Availability of audit trails and log system to track identity changes

¢ To meet company specific requirements for user access management solution
e To prevent the unauthorized access to company resources- Enterprise

applications, Database, Webapps, Active Directory, etc. in multi- enterprise
environments
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SAP Identity and Access Management
( SAP IDM)

I
SAP applicationsre/crm)  Non-SAP applications

SAP SCM

Java Lotus Notes

Database

Active Directory

SAP ERP HCM SuccessFactors Legacy

o]

MS Exchange

SAP ERP Web Apps

SAP HANA

Key Benefits

Following are the key benefits of using SAP Identity Management:

e To ensure that user permissions are assigned to required systems at right time and
prevent unauthorize access

e Consistency in managing user roles and permission across multiple complex
enterprise landscape

e Secure execution of business approval workflows and processes

e Ease of managing audit trail and log systems for tracking

Right Access to
Users and Systems
at the right time

Secure & Efficient
execution of
Business Processes

Manage identities and
permissions

SAP Identity

/ Management

Consistent User and
Privilege management
system

Audit Trail and Log
access for tracking
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2. SAP IDM — Architecture

SAP identity management system is used to maintain identity data across different ECC
applications. You can import data from different SAP applications to IDM based on available
authorizations. From backend application, after importing the authorizations- privileges
are added to system and this is then sync to backend applications.

User interfaces are used to perform the different self-management identity tasks in identity
store and changes are replicated back to backend applications.

Logon Browser | Logon
Help Help

Windows PC H Windows PC

Nntities
User Interfaces

Identity
Federation

Identity
Store

Privilege Identities & Acces
Directory
Database & Web apps
TS Non-SAP

™~

System

Most of SAP Identity management components run on NetWeaver application and Java
server. Few of important component of SAP IdM includes:

e SAP Identity Store

e User interface for users and Administrators
e IdM Database

e IdM Developer Studio

e Developer Studio Service

e Runtime component

Identity store provides a consistent view of identity data from multiple sources and helps
in managing business processes, logging and auditing, password management and
reporting feature for access management. Identity center collects the data from different

w tutorialspoint
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application repositories, transform to required formats and replicate it back to source
repositories.

Few components of IDM run on SAP NetWeaver AS for Java and this includes Identity
Management User Interface for users and administrators however few of other
components are installed separately and stand-alone components. Key components of SAP
IDM architecture mentioned below:

User Interface Administrator
I : Developer
Admin
i SAP NetW
REST V2 User | "User [l e stiWeaver
Interface Service Dev Studio Service
Interface |Mceam)
User Interface B 8
&_ IDM Developer

I[dM

Developer Java Server
Studio IDM Developer Studig

Identity
Store

Business’ Config

workflo; Package

Administrators can install SAP Identity Management using Software Provisioning Manager
1.0 installation tool. Provisioning Manager 1.0v installs all SAP Identity Management
components except IDM Developer Studio client, Logon Help and SAP IDM Password
management utility. Mentioned components to be installed manually using external client
tools.

SAP IDM Dispatcher Utility

This is used to create new dispatchers in IDM system. With use of user interface
component- you can also stop or start the dispatchers. This can be done via user interface
component or using command line option.

IDM Runtime Engine

This component of IDM is used for synchronization and provision tasks and requires SAP
Java Virtual Machine for execution.
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3. SAP IDM — Installation

You can install SAP IdM system in distributed environment where each process runs on
separate system. You can use any of OS to perform the installation and select any of
database like MS SQL, Oracle, DB2, etc.

You can use Software Provisioning Manager (SWPM) tool for performing the installation of
IdM. By following the below steps, you can install SAP IdM:

Installing IdM core components

To install IdM core component, login using an OD administrator account and stat Software
Provisioning manager tool (sapinst.exe) and select SAP Identity Management 8.0 >
Installation - Distributed System - SAP Identity Management Core Component as shown
below

Go to the option you want to execute.

Available Options Describlion
* [] 5AP Business Suite 7i 2013 Suppor Release 1 Installz the Core Component of SAP Identity Managemant 8.0 on this
¥ [] 5AP Business Suite 7i 2011 Java host
¥ [] SAF Business Sulte 71 2010 Java
¥ [ 8AF Business Suite 7 Suppon Release 1 Java
¥ [ 54 Solution Manager 7.2 Support Release 1
¥ [T] SAP Solution Manager 7.1 powered by SAP HANA
= 15 SAF Identity Management 8.0

= 75 Installation
» [] Standard System
= v Distributed System
. 'h SAP |dentity Management Cora Componant

. ‘}n; SAP |dentity Management Dispatcher Instance

Run the installation in Typical mode. You need to pass you SAP SID and destination drive
after staring core component installation.
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Define
Parameters

Enter the systerm ID and destination drive.

SAP System

*SAP Systermn ID (SAPSID) IhdJ

Destination Drive
Additional Information

The SAP Systern IDis an identifier for your SAP system. It must be unique throughout your system landscape.
The system is installed under <Destination Driwe>:‘\usrhsap\<SAPSID>%....

Follow the installation steps and pass the path of SAP archives, SAP host agent, etc. Next
you will be prompted to select the database system:

. 4
Define Review Execute Service
Parameters Parameters Service Completed

Selectthe database type for your SAP Identity Management installation.

Database System

Database Type
Additional Information

SAP ldentity Management supports the following database types:

= Wicrosoft SQL Server
* QOracle
« |BM Db2 for Linux, UNIX, and Windows (1BM Dh2)

Provide the host name where database is running, port# and credentials for IdM database:

w tutorialspoint
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Define Review Execute ervice
Parameters Parameters Service Completed

Enter the credentials for the SAP |dentity Management database.

Database Credentials

*Administrator User sa
*administrator Password
Additional Information

The Administrator Useris the user name for the system administrator.

The Administrator Password is the password for the systern administrator.

In next window, you have to provide the Database schema prefix and base qualified name
to be used for IdM packages:

Define e t arvi
Parameters Parat 1

Enter the SAP Identity Management database parameters

SAP Identity Management Database Schema and Base Qualified Name

*Database Schama Prefix Sp—

*Base-Qualified Name - ]

Additional Information
The Database Schema Frefixis the prefix of the |dentity Management database.

Ifyou want 1o have several [dentity Management databases on the same installation of Microsoft SQL Server, Oracle, SAP ASE or IBM
Db2 for Linux, UMK, and Windows (IBM Db2), each SAP [dentity Management database must have its own prefis

Wig recommend using uppercase alphanumeric values (A&-Z, 0-9) for the prefi, except for IBM Db2 on UNIX operaling systems, where
the prefix must contain lowercase alphanumeric values onky (a-z, 0-9), ¥WWhen using IBM Db2, make sure that the length ofthe prafix
does nol exceed hwo characlers. For example: 1C (onWindows) or ic (on UNIX operating systems)

The Base-Qualiiied Mame is used for all SAP |dentity Management packages in this database. The Base-Qualified Narme can contain
only alphanumeric values (&-Z, a-z, 0-9), underscore {_) and period (). For example: com.acme

Back Mexd Cancel

Pass the other parameters in subsequent steps and follow the instruction steps and click
on Next button to run the installation. When the installation of IdM core component is
completed, below message will appear:
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Define Revie Execute Senvice

Parameters Parameters Senice Completed

1 U Oo/n Process is in dialog state
Execution of Service has been completed successfully.

Execution of
SAP |dentity Management 8.0 = Installation = Distributed Systern = SAP Identity Management Core Component

has completed.

Installing SAP IdM runtime and other developer components

Logon to other host where you want to install IdM runtime and other deployable
components, and open Software Provisioning Manager and select SAP Identity
Management 8.0 -> Installation > Distributed System -> SAP Identity Management
Dispatcher Instance.

Go to the option you want to execute.

Available Options Description

» |:| SAP Solution Manager 7.1 powered by SAP HANA e e b L
~ T5) SAP Identity Management 8.0
~ 5 Installation
» [] Standard System
~ t5) Distributed System
. ‘ﬁ SAP ldentity Management Core Component
" QQ SAP Identity Management Dispaicher Instance

. “Q SAF Identity Management Components on SAP Netie. ..

» [7] Additional Components

Software Provisioning Manager Legend

» [T] SAP Solution Manager 7.2 Support Release 1 Installs an SAP Identity Management 8.0 Dispatcher instance

Start the installation process in a Typical mode and provide the profile ddir patch of SAP
IdM system as shown below:

w \tutorialspoint

EIMPLYEAEGBYLEARNINTIEG



SAP Identity Management

Deﬁna ne Execute efrvice
Parameters imetet erice ompleted

Enter the profile directory ofthe SAP systerm.

SAP System Identification

Profile Directory P—— e

Destination Drive
Additional Information

Existing parameters are retrieved from the SAP system profile directory. The location of your SAP systemn profile directory is as
follows:

Follow the steps as per installation steps and pass the instance number assigned to SAP
IdM dispatcher or you can also use the default value.

Define
Parameters

Enter the identity management instance parameaters

ldentity Management Instance

The following SAP system instances already exist on this host
SAF System ID (SAPSID) Instance Mame Instance Mumber
1
2
3
¥Instance Mumber 0z

Additional Information

The Instance Murnberfor the identity management instance is a technical identifier for controlling internal processes, such as
assigned memaory This number must be unigue for this installation host.

In the next step, provide the driver path and JDBC driver class name. Review the
parameters and proceed with completing the installation steps.

w \tutorialspoint
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Define
Parameters

JDBC Driver Path and Class Name

*Path to JDBC Driver

Browse

*JDBC Driver Class Name
Additional Information

Enter the JDBC driver parameters for your SAP Identity Management database.

ClusrisaplidmiJDBC Drivers/iMSSQL JDB

com.microsoft.sglserverjdbe.SQLServerD

Installing SAP IdM deployable components

Open Software Provisioning Manager. Select SAP Identity Management 8.0 - Installation
- Distributed System > SAP Identity Management Components on SAP NetWeaver AS

Java.

Go to the option you want to execute.

Available Options
» | 7] SAP Solution Manager 7.2 Suppont Release 1

¥ [T SAP Soldtion Manager 7.1 powered by SAP HANA
- TS SAP Identity Managerment 8.0
= 15 Installation
¥ [] Standard System
- 5] Disfributed Systam
- c.ty SAF Identity Management Core Component

= %y SAP Identity Management Dispatcher Instance

» [ additional Camponents
» [ Update
¥ [ SAP MDM 71
» [ sAP Netweaver AS ABAP 7.4, OEM version 1.0
¥ [C] Dual-Stack Split
» [ Systerm Rename

» [ Generic Options

* % SAP Identity Management Components on SAP Netwe,,

Description

Deploys the following SAF Identity Management 8.0
companents on this host

= Mandatory components:
o SAP Identity Management 8.0 Developer Studio
Sermice
e SAP ldentity Management 8.0 User Interface

« Additional components
= SAP ldentity Management 8.0 REST Interface
warsion 2
o SAP Identity Management 8.0 User Interface for
HTHLS
= SAP ldentity Management 8.0 Portal Content
= |dentity Federation

Run this option on a host where SAP NefWeaver AS Java is
installed and where there is at least one AS Java instance
running

This will install the below components:
Mandatory Components

e SAP IdM Developer Studio Service
e SAP IdM User interface

Additional Components

ASBEYLEARMNINIG
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e SAP IdM REST interface
e SAP IdM Portal Content
e Identity Federation

Follow the steps in previous installation and provide SAP SID of the NetWeaver Java
system where these components to be used:

Define Review Execute ervice
Parameters Parameters Service “ompleted

Enter the SAP system ID of the SAP NetWweaver Java system to be used for the SAP |dentity Management system.

SAP NetWeaver System

SAP Systemn ID (SAPSID) DM ~

Additional Information
This is the SAP Systern 1D (SARPSID) of the SAP NetWeaver Java system that is to be used for the SAP Identity Management
components you want to install or update.

Back Mext Cancel

In the next step, you need to select the additional IdM deployable components you want
to deploy:

Select additional SAP Identity Management components to be installed.

Additional IDM Components

“erify that the prerequisites and dependencies between components deployed on SAP NetWeaver AS Java are met, as
described in the Planning section in the SAP Identity Management Installation and Update Guide at hitp:iihelp.sap.comiidm.
Otherwise, the deployment on AS Java might fail.

v SAP Identity Management REST Interface Version 2

v SAP Identity Management User Interface for HTMLS

v/ SAP Identity Management Portal Content

v Identity Federation
Additional Information

SAR Identity Management REST Interface lfersion 2 is a service APl that supports the ldentity Management User Interface for
HTMLS and other custom-made user interfaces. SAP OData library {(odatadj) is required for this component.

SAP Identity Manaagement User Interface for HTMLS is a user interface based on HTML5 and JavaScript. develoned usina the

After selecting the additional components, click on Next button and installation will
complete for SAP IdM deployable components.

11
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Additional Information

SAP Identity Management REST interface Version 2 is a service AP that supports the Identity Management User Interface for
HTMLS and other custom-made user interfaces. SAP OData library (odatad)) is required for this component.

SAP idenity Management User Interface for HTMLS is a userinterface based on HTMLS and JavaScript, developed using the
SAP Ul Development Toolkit for HTMLS (SAPUIS). It also uses the SAP Identity Management REST Interface Version 2. The
SAPLIS library Is reouired for this component

SAP Identity Management Portal Contentintegrates SAP Identity Management with the Universal Worklist (UWL), Configured
Universal Worklist (LW¥L) on the portal is required for this component.

Identily Federation is used for Single Sign-On (S50) for SAP and non-SAP systems. It supplies a SAML 2.0-compliant identity
provider for web-based access, and a security token service forweb semvices S50,

Back et Cancel

Installing Active Directory Server Virtually

Open Software Provisioning Manager and select SAP Identity Management 8.0 -
Installation - Additional Components - SAP Identity Management Virtual Directory
Server. This will install Virtual directory server instance 8.0 on selected host.

Available Options
» | ] SAP Business Suite 7i 20186

Description

» [] SAP Business Suite 7i 2013 Support Release 2 Management 8.0 on this host
» [:l SAF Business Suite 7i 2013 Support Release 1
» [] SAP Business Suite 7i 2011 Java
» [] SAF Business Suite 7i 2010 Java
» [:] SAP Business Suite 7 Support Release 1 Java
» r_—l SAP Solution Manager 7.2 Support Release 1
] r_—l SAP Solution Manager 7.1 powered by SAP HANA
¥ 5] SAP Identity Management 8.0
~ 15 Installation

» [] Standard Systern

» [] Distributed System

¥ 5 Additional Components

* %% Additional SAP Identity Management Dispatcher ...

. “g SAP [dentity Management Virtual Directory Serve. ..

Installs a Virtual Directory Server instance of SAP [dentity

Follow the installation steps and provide instance number to assign to Virtual Directory
server or you can use default provided.

12

w tutorialspoint

EIMPLYEAEGBYLEARNINTIEG



SAP Identity Management

Enter the identity management instance parameters.

Identity Management Instance
The following SAP system instances already exist on this host

SAP System ID (SAPSID) Instance Name Instance Number

(o8]

=
_—
_—

w tutorialspoint

EIMPLYEAEGBYLEARNINTIEG

4 C
*Instance Numhber 03
Additional Information
Next step is to review the parameters and complete the installation process.
Software Provisioning Manager Leg
1 0 0% Process is in finished state
Execution of Service has been completed successfully.
The process execution is finished successfully
Exit
13



4. SAP IDM — Developer Studio

SAP IDM Developer Studio is an Eclipsed based plug in and used to configure Identity
management solution. This is a client-based tool and has to be installed on each developer
or administrator system. To enable Identity Management developer studio, From Eclipse
User interface, navigate to Help -> Install New software.

File Edit Navigate Search Project Run Window lHelp |

FY v q - L: &y v - v 'ZZE.) Welcome
CollabNet Sites 52 =) (?) Help Contents
2 P ’ =1l C B¢ %7 Search
ic Hel

€) CollabNet OnDemand Dynamic Help

{J) CollabNet TeamForge Community Key Assist... Ctrl+ShiftL

. Tips and Tricks...

4/ Report Bug or Enhancement...

Cheat Sheets...
Check for Updates
Install New Software... h

About Eclipse SDK

Next is to provide the repository site where the plugin is available from. Click on “Add...”
as shown in below screenshot:

{ < Install - @}
Available Software |

Check the items that you wish to install, 3) =
work with: | ccf-gui - http://ccf.open. collab.netjupdate-site/ ﬂ | Add. .. |

Find more software by warking with the ‘2valsble Software Sikes’ preferences.

MNarme Yersion
=[» CollabMet Connector Framework 1.4.10
'-{f:= Project Tracker Connector for Ct 1.4.9
=Jr Quality Center Connector for CC 1.4.8
|:|‘:'J‘&; ScrumWorks Pro Connector for € 1.4.7

This will open Add Repository dialog box, pass the name like- "SAP Identity Management
Developer Studio: and under location field, pass URL of Identity Management Developer
Studio plugin. Provide this URL https://tools.hana.ondemand.com/oxygen for Eclipse
Oxygen (4.7) -> OK.

14
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When you expand SAP Identity Management Tools, Select SAP Identity Management
Developer Studio checkbox and click on Next.

% SAP Identity Management Developer Studio - com.sap.idm.taskflowdiagrams /F73C4E17-7D45-4700-BA7B-13E9528B6892.diagram - Eclipse
Fle Took Edt Mavigste Search Project RBun  Window Help

ra . Q) Q- . - ¥5 5 . Juiick Acce [ | & Java | ] SAP Identiy Management Developer Stud
I 5P Identity Management = [ Createlavallser 2 T = [ Byloblog [IDM/com sap.idm.connector.asjaval &4 =
El <F] B General| Result Handling Logging | State | Documentation 2 ‘ ISR IF )
= & Management = = = =
Bl J0b Log [type fiter

B Execution Log [ Enabled
@ Repositorles

=8 Dispatchers

Job | Type I Date/Time | Statuf
i 61)aS)avalB - Initial L., Job 2014-11-26 09:59:56 oK
4]

Task ID/Name: | 175/Creatslavalser

% slserver T
-8 SAP NetWeaver Tdentity Management & Job 10: [s7 I Auomatically RefreshEvery o0 7] Seconds
= & Identity Store Schema -
53 Eriry Types | | A

B9 attributes
= Packages
= 5.{;\1 com, bestrun, NewPackage
[ g com.sap.idm, connector.abap
[ g8 com, sap.idm, connector. abap.bi
[ com,sap.idm, connactor.ad

I Bllowe Parallel Pravisianing B Job Log Detail-174 52 = H

~5cheduling, Dispatchers and Retries — -
HTMD, 0L Text|

Prowision hd
N

Schedule Rule:

Run by Dispatchers: [ salserver

[=-&H com. sap.idm, connector.asjava
= 1t Log
Repository Types
& Scripts
& Constants
-1-(% Processes

Mo, of Retries:

Retry Delay:

1
[30 [seconds >

¥ Right Trim Source Attributes

Synchronization Log 2014-11-
26 09:59:56

(% Plugins
@ (% Triggers
=5 riities
=1y Jobs 202/CreateUser/IDM £2 = 08
1 ASJavaDB - Initial Load B
P ASJavalDAP - Initisl Lot
15 E} o can idem cgnackor bu ‘LI

Product Identity Center

DSE.JAR version: 8.0.0.0 Built:
21.11.2014 03:14:02 - 203219 (c)
Copyright 2012 SAP AG. All right
reserved.

Version
o Palette b

= Tacks £

Configuring SAP IdM Developer Studio

In SAP IDM Developer studio, you can add connection to IDM database. You need to pass
the below details:

e Application Server name
e Port

e Data Source

Under Preferences -> Connections -> ™ click on + sign “.

& Preferences

Connections = v

|

|- General

ant

Help

Install{Update

Java

|- Plug-in Development

] Run/Debug

|- SAP Identity Management

Application Server Configuration

SAP Identity Management databases

Application Server: I localhost

[+ [ [ [ [ [

Port: | 50001

DataSource: IIDM_DataSource_DevStudio

Connections

Provide the required information and click on OK to add the Database. Once you add the
database, you can expand and see the tree view.
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= Preferences Hi=] E3

|r:-r.ﬁ filker text Connections .__;:, = - -

[+ General

[+ Ant

- Help SAP Identity Management databases ﬂ ;l Application Server Configuration

[+ Install/Update —

- Java ' |

racle .

- Plug-in Development DM DB2 Application Server: |Incalhost

[+ Run/Debug Part: | 50001

[=]- SAP Identity Management -
R DataSource: I IDM_DataSource_DevStudio
Global Settings
Logging

[+]- Team

Restore Defaults | Apply I

)
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5. SAP IDM — Setting up the Framework

In SAP Identity Management, you can use set of templates to connect to SAP systems and
setting up the jobs, processes for different tasks. A Package in SAP IDM is smallest unit of
code that can be a connector type or set of utilities used by other packages. Administrators
can gran permissions to user to transport each package separately and then work on
configuration to customize them. IDM provides configuration packages as default
component to provide starting point customization.

Each package is identified with global unique name which means you cannot have same
package name in any of identity store.

Fle Tools Edt Navigate Search Project Run Window Help
- ) Q-3 g S ER I 7 - Jouick Acce =9 | & dava | 7 5P Identiy Manag|
m SAP Identity Management =8 & CreateJavalser &3 ven 85 Job Log [IDM/com.sap.idm.connector.asj3
=13 oM Al General| Result Handling Loggmg! StatejDocumentauon Sl m
= g Management
@3 3ob Log It
B3 execution Log IV Enabled Job T Date,
@ Reposkories Task ID/Name: [ 179]Createlavallser i 61/AS)avaDB - IntialL... Job  2014-11-
=)~ Dispatchers < |
4 sqiserver -
()-8 5AP Netweaver Identiy Management £ Job ID: |s7 I Asomaticaly RefreshEvery [0 |
= ,ﬂ Identty Store Schema
103 Entry Types «
104 Attributes r Peralel by
N =@ ::;lwoas ok & n @ Job Log Detail-174 52
[ 48 com. bestrun, NewPackage 5 = ~ <
g Scheduling, Dispatchers and Retries @ S
[ com. sap.idm.connector. abap [HTMLY, XML | Text |
[ g com.sap.idm,connector. abap.bi Schedule Rule: Provision v - -
g com.sap.idm.connector.ad R Dispatchers: - . .
(=g com.sap.idm.connector.asjava unly 2 | vy SYDChronlmtlon Log 1
1. DU . OO0 swpy s

You can usually find below package types:

Engine package

This package provides the core flows which are responsible for triggering the necessary
processes and other common scripts used in other packages.

Connector package

This package provides the connector, which is used for provisioning the specific systems
like SAP ABAP, etc.

Forms package

This package stores definition of all user interface tasks for different transaction types

Notification package

This package contains the notification task and templates which are used to send
notifications for provisioning, approval tasks and business work flows.

Custom package

This package is used to customize the provisioning framework without altering the other
stored packages. This package contains the customize scripts from other customers and
few of default custom scripts which can be used to customize other packages.
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User Authorization to access packages

To access the content of package, user must have required authorization on that package.
Below authorization exists for packages:

e View
e Developer
e Layout Developer

e Import

e Owner
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6. SAP IDM — Repository Types

To connect your SAP and non-SAP system to SAP Identity Management, repositories has
to be created based on different types. Repository type tells the common constants for all
the repository type available and assist in repository configuration process.

Below are the advantages of using Repository type:

e For all the repository type, you can change repository constant and this will apply
to already existing and new repositories.

e You can also add new constant for all the repositories of any types and this
includes existing and new repositories.

You usually require changes to the Repository type of given repository in following
scenarios:

e While upgrade SAP Identity Management from v7.2 to 8.0 and to use provisioning
framework in SAP IDM 8.0. This will allow you to configure v7.2 repositories to
change type of repositories delivered in new framework.

e There is custom repository type with the custom features and you want to change
any existing repository type to custom.

To change the Repository type, you have to log on to SAP Identity Management
Administration UI- “http://<host>:<port>/idm/admin”.

Next is to choose the System Configuration tab -> click on Repositories from left menu.

Monitoring | Trace | Configuration Histoqt_:] Statement Execution i Mel

» Repositories Find Repository: | |
« Packages [ Export 4 || Change Repository Type |

You can select a repository which is disabled and click on “"Change Repository Type”.

Monitoring Trace | Configuration History / System configuration } Statement Exec ution | Message T|
- Reposilories ‘ Find Repository: | | (Go)
= Packages [ Export « |[ Change Repository Type |
ID | State Name = Type
" | 1 @ Enablec  ADAM LDAP
| 6 @ Enabled ADS LDAP
1o (O] Disabled  ASJAVAT30 ASJavaDB
| s @ Enabled ASJAVATIO_OLD JANA
" | 4 @ Enables BQQ720 ABAP
] 2 @ Enabled HAMNA sap_hana
] 3 @ Enabled NOTIFICATION sap_notific ation
| 7 @ Enabled SUN sap_sun_pf
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Next is to Select the Repository type -> Provide description (optional field) -> OK. Next is
to validate the Repository constants and fix the values if required as below.

Details of Repository "IDENTITY_AUTHENTICATION":
Constants | Jobs

Edit constants of repository "IDENTITY_AUTHENTICATION"

|[&) save || 5] Refresh |

Name = | Value
T

PROXY_PORT

PROXY_USER

READ_TIMEOUT 60000

SCIHOST e

You can also view the Repository changes history by navigating to “Configuration History
Repository Operations.

Menitoring Trace Configuration History |7 system configuration | Statement Exec ution Mel
» Repositories Find Repository: |
» Packages | Export « || Change Repository Type |

You can also view the Repository constants changes due to change in the Repository type,
Navigate to Configuration History - Repository Constants
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7. SAP IDM — Using Identity Stores

In SAP IDM, information stored in Identity stores are used in provisioning framework and
this provides a centralize repository for managing identity related information like Dept,
Emp name, Groups, BU, etc. Identity store also provides extensive audit trail and tracking
functionality to monitor attributes which can be changed.

T3 Fle Acton View Favorites Tools Window Help

e T HneEasdD ) n @ 0E

- Console Root
= & SAP Netweaver Identity Management
[ 4g Standalone jobs
= I mxmc_db
= % Management
@ @ Identity stores
B [ Job folder
Ak status
= 2 AD Stuff
@4 status
®= ¥ AD Load
= F® Read AD - [DS]
= @ Read Employee ID from AD - [DS]
Bl System log
B3 Job log
(3 Scripts
iH Job variables
iy Job constants

Repository Sourwl Destinalionl Delta] Documentation
—LDAP source

LDAP URL: |LDAP:,";%$rep.LDAP_HOST%'%$rep.LE

Directory login name: %$rep LDAP_LOGIN:

Directary login password:  [%¢rep LDAP_PASSWORD%

Protocal: [DARZ

LDAP3 @

DAP.. | C
Character set |UTF-8 =]
Security option: ISimpIe authentication LI
Alias resalving: INever LI

Usually an Identity store is connected to identity management user interface in SAP
NetWeaver AS for Java and each Java installation can only connect to one identity store.
There are number of system attributes added in the system when an identity store is
created. There is an identifier- MSKEYVALUE which stores unique identifier in Identity store

across all entry types.

In Identity Management, you use entry type to define an entry property such as allowed

and mandatory attributes.

Note: MSKEY number is unique across in an identity center across all identity stores.
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= SAP Identity Management Developer Studio - Eclipse

File Tools Edit Navigate Search Project Run  Window Help

(3~ & G D AORE DL g e B [
SAP Identity Management = O [ *Self Service: Assign Privilege 237
= l.f Root General | Result Handling |Parameters Access Contr0|| Presentation | Documentation

=I5 1D _SCQLServer
3 3 Management
=& Enterprise People Enkry bype: |1?,|'M><_PERSON _I
# ,Q Identity Store Schema

= Packages

=] - 5am, P
¥ i;uszT:DLNew ackage! ™ Context is Mandatory
ob Log
(- %@ Repository Types Context Type: INone ;I
:F Scripts [~ Mulkiselect Context
;6 Constants Reference Type: [Mi_PRIVILEGE |
(% processes -

B Forms W mMultiselect Reference
[ self Service: Assign Privilege sk For validty: |8
[+ 4 Jobs
Ask for Reason:  |Optional -
+- I3 1DM_Oracle I P —I
+ 153 1DM_DB2

Managing Entry types in Identity store

Usually it is not recommended to delete entry types in an identity store as they are
required for audit trail and tracking purpose. You can mark it as inactive or use a state
field to mark the status of that entry type.

Ex: An employee can join back a company later and in that can it simplifies the process if
the same entry type can be used for that employee.
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fction View Favorites Tools Window Help

s=|2F 4 o 0XcHBRe=sdD ) n @ OB

= & Management
Q}: Status
By System log
By Joblog
# (3 Global scripts
By Global variables
53 Global constants
[ @ Repositories
[+ @ BQQ720
[ @ NOTES
[# @ NOTIFICATION
fﬁ Scheduling
= % Dispatchers
-8 72Inca
[@ External event handlers
= 'l Identity stores
Dy Attribute types
=] @ Enterprise People
[+ & Identity store schema
[# & Identity store metadata
1 Lost and Found
[= ([ Provisioning Framework
= @@ CoRE
= [0 Web Enabled Tasks
= 2 Identity

Xl Change Own Data (Self-Service)
Xl Request Role Assignment (Self-Service)

[ Display Identity
X Create Identity
I Modify Identity
X Assign
X Disable Idenkity
= M Inactivate Identity
[+ @@ Inactivate Identity
) Identity SearchTask
= [ Delete Identity
= = Delete Identity
= E{ Delete Identity
B3 system log
B3 Joblog
(3 Scripts
15§ Job variables

04 Job constants

[¥oeers e

2l

Hepwiuryl Source Desh'ﬂaliﬂnl Dela] Ducumentd'ml

~ Destination | dentity store

|dentity store: IE nterprise People

Entry type: [Mx_PERSON
Multivalue delimiter: ||
User info: Jobld=%$ddm meiob?

Insert template I

Ll <

| Aittribute ‘Vaha
MSKEYVALUE %MSKEYVALUE
ChangeType delete

)
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8. SAP IDM — Identity Center Properties

Identity Center is the main component of SAP IDM which provides key functionality for
identity management system. Identity center uses identity store to manage all the key
functions. SAP Identity center is usually installed with a management console, and other
runtime components. For using logon service via Active Directory server for self-service
password management, SAP IDM should be configured with Identity center.

Following are the key functions performed using Identity Center:

e Password reset

e Business and workflows

e Logging
e Audit trail
e Reporting

e Provisioning

File Action View Favorites Tools ‘Window Help

R - B G

] Console Roat R .
= @? SAP Net\Weaver Identity Management Database | Options i| Yersion info
# Standalone jobs
= MEMC System log
£ Management Log levek i
[+ &l Identity stores s I nia 3 [~ Enable trace
(] Job folder Max entries: |1IJIJD
Job timeouts Bootstrap Job timeouts
Idle timeout f3600 seconds
Start timeout: |3|JL'I seconds  Stattimeout  |86400
Execution timeout: |300 seconds  Ewecution ti'neou:|35400
Max restarts: |5
Import / Export options -
Log file: |C‘\usr\sap\IdM\Identity Center\lmx<port log Browse...
Log levek: [info =l [V Enable imported jobs
Default dispatcher: |locahost2 =l [~ Check in imported jobs

SAP Identity Center contains the following components:

Management Console

Management console is a plug in in MMC and is used for setting up the starting
configuration for different tasks and jobs in provisioning flows.

Database Management
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SAP Identity center uses the database to maintain all the information about provisioning
tasks and business workflows, logging information and audit trails, and identity store, etc.
You can use following DB’s in identity Center:

e Oracle Version 10/11
e DB2
e MS SQL Server 2005/2008

Copying Identity Center Configuration

To copy SAP Identity center configuration and data from one database to other, you can
use system copy. For this task, you can find job in SAP Community network. Download
the Zip file from SCN and extracts the file and below steps to be performed:

o Creating Dispatcher
e Import the job folder
¢ Configuring the imported repository

To pass dispatcher script, you have to navigate to Options Tab -> Create Dispatcher
Scripts

Dispatcher task execution policy

Check intv.: |5 Secaonds j
I~ Handle tasks

[~ Evaluate relations

[~ Evaluate approvals

[~ Housekeeping actions

Housekeeping inty: I3g Seconds El

v Runjobs

{ Ogtions 1| Policy | Jobs |
Name: fidmaispatchert Create dispatcher scripts...
Version: [MxDispatcher v7.28.0
Max rt engines to start: I 1 Last check: | 1/30/2013 3:.06:43 PM
Max concurent it engines: I 0 Log level |Em:|l LI

Max loops for it engine: | 10 Advanced |

After script is created, you need to pass the details for run jobs and runtime engine. To
define this, navigate to Policy tab - > select Run Jobs check box.
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Dispatcher task execution policy

Check intv.: I 5 Seconds LI
I~ Handle tasks

I Ewvaluate relations

[~ Ewaluate approvals

I Housekeeping actions

Housekeeping inty: Igg Seconds EI
v Bun jobs
Jawva runtime engine
[~ Run provisioning jobs Log levet |Info LI
[V Run regular jobs Stack trace: | Topmost entry =l
Jawva options: I

Windows runtime engine
[T Bun provisioning jobs

I~ Run regular jobs

You can check the Dispatcher status under Options tab -> To update the status click on
Refresh button. The status is showing under Service state field.

. Options “I Policy | Jobs |
Mame: |idrndispatl::her1 Create dispatcher scripts...
vt [MiDispatcher v7 280
Max it engines fo start. | 1 Lastcheck: | 1/30/2013 3:06:43 PM

Max concument it engines: I 0 Log level: |Em:-r :]
Max loops for it engine: | 10 Advanced |

Status: Running threads: JOBEXECUTE

‘Windows Service

Service state: ]Flunning Refresh | Test |

You can also select dispatcher service to auto start. For this, select the checkbox Automatic
start field to enable the same.
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Max loops for it engine: I 10

{Options | Poiicy | Jobs |
Name: [idmdispatchert Create dispatcher soripts...
Version: M=Dispatcher v7.2.8.0
Max it engines to start: I 1 Last check: I 143072013 3:06:43 PM
Max concurrent rt enginesl 0 Log level: |Enor j

Advanced |

Status: Running threads: JOBEXECUTE

‘Windows Service

Service state: |Flunning

Refresh I Test I

s | sep |

Uninstal I [V Automatic startup

You can also manage Dispatcher job to stop/start manually. For this, you can use Start

and Stop option below Service State:

Max loops for it engine: I 10

Name: Jidmispatcher1 Create dispatcher scripts...
Version |M:Dispatcher v7.28.0

Max it engines to start ﬁ Last check: I 1/30/2013 3:06:43 PM

Max concument it engines: Iiﬂ Log level: |Elror j

Advanced |

Status: Running threads: JOBEXECUTE

‘Windows Service

Service state: |Flunning Refresh I Test I
Start I Stop Install I Whirstall I v Automatic startup
27
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9. SAP IDM — Maintaining Packages

As mentioned earlier in this tutorial, Package is smallest unit of configuration which can
be a connector or collection of utilities used by other packages in Repository. Few default
packages are delivered as a part of Identity management core component and imported
to database to provide the starting point for solution.

Package has set of features which are used to maintain them in the Identity management
repositories. Following are the key features:

e Package Qualified name
e User Editing

e Authorization

e Version control

e Objects

e Transporting packages

Package Qualified Name

Each package in SAP Identity system has qualified name which contains base nhame which
is provided during installation and package name which is passed during package creation.
Base name passed during installation usually contains alphanumeric, numbers, underscore
and dot. Ex: XYZ.com. Package name passed during package creation is globally unique
i.e., you cannot have same package name in different identity stores in SAP IDM.

User Editing

To make changes to a package, you must check out and once changes are done, you
should check in to make updated configuration available to other packages. When a
package is checked out, no other user can make the configuration modification to that
package.

Authorization

To access the package content, user should have permissions on that package. Users can
have different level of authorization on packages in identity store. Below are common
authorization exists on the package:

e Owner

o View

e Developer

e Import

e Layout Developer

Version Control
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Using version control of package, you can restore the previous version of the package.
Package usually has two version humbers, Major version and Minor version.

Major Version: Whenever you make changes to a package and make it public, major
version is incremented.

Minor Version: When you check in a package every time, minor version is incremented.

Objects
You can define the objects used in package as public or private. A public object can be
called by other packages.

Transporting Packages

Each package in an identity store is transported separately.

Note: To perform provisioning framework in SAP IDM Developer Studio, you must import
an engine package, a custom package and connector package.

ﬁ SAP Identity Management e

= Lf Root
=153 IDM_SQLServer
8 Management
[=-& SAP NetWeaver Identity Management 8.0
B 1dentity Store Schema
=-[*# packages
&_}'} com.sap.idm.connector.abap
té* com,sap.idm.connector,abap.businesssuite
& com,sap.idm,connector.ad
tﬁ* com,sap.idm.connector, asjava
Eﬁ} com.sap.idm.connector.custom
## com.sap.idm,connector . dualstack
com.sap.idm.connector.hana
tf'}* com.sap.idm, connector.notes
& com.sap.idm.connectorsfsf
## com.sap.idm.connector.sun
## com.sap.idm.Forms.default
## com.sap.idm.Forms. htmiS
Eﬁ} com.sap.idm.provisioning.engine
## com.sap.idm, util.notification
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10. SAP IDM — Using Processes

In SAP Identity management, you can create new processes and use developer studio to
drag processes in workflow. You can disable/enable packages by navigating to Package
properties.

Navigate to General tab of process properties to enable/disable the Process. Under General
tab, you have the following options:

e Field
o Description
e Enabled

e Process ID/Name

Process ID shows the number that is used to identify the process in IdM database.

File Tools Edit MNavigate Search Project Run  ‘Window Help
o = : Eq-;.;'- - Lo v|

IE9 sAP Identity Management = 0 [ Createlavallser 23 =0

=53 1om ﬂ ngerall Result Handling Lnggmg| State | Documentation
=& Management
&0 30b Log
B3 Execution Log v Enabled
W Reposkories Task ID/Name: [ 179/Createlavaliser
=% Dispabchers
-3 solserver
(-8 5P Netweaver Identity Management & Job ID: |57
= Q Identity Store Schema
§ Entry Types
g @$C$SUtﬁ [~ allow Parallel Provisioning
2 gﬁj com.bestrun, NewP ackage
[ 5@ com. sap.idm. connector.abap
& &8 com.sap.idm. connector.abap.br Schiedule Rule: Ivaision j

[ e com,sap.idm, connector.ad Run by Dispatchers: & sqierver
I; gﬁﬂ com. sap.idm. connector. asjava

iy R

+- 4 Repository Types Mo, of Retries: I 1

| g Scripts | Retry Delay: |30 fseconds =]
. oo Constants
| (™ Processes I¥ Right Trim Source Attributes
H:: % piugins

(% Triggers
P e o

General

—Scheduling,Dispatchers and Retries

Using Process Properties

A process in an Identity store defines the set of operations that are executed in a particular
sequence. You see the below options for Process property:
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File Tools Edit Mavigate Search Project Run  Window Help

= 5 (?) _CL-_A;:‘-_ v > o5 . ,‘ X
SAP Identity Management = 8 &= Createlavallser §3
= IDM B Generall Result Handling ‘ Logging ‘ State ‘ Documentation
= g Management
B3 10b Log
. BY Execution Log ¥ Enabled
@ Repositories Task ID/Name: | 179/Createlavalser

B —& Dispatchers

- General
£ sqlserver

=W SAP NetWeaver Identity Management Job ID: I 7
= Q Identity Store Schema

General

Using General tab, you can enable/disable the process or define the process type. You can
also define a repository for the process.

Result Handling

This tab can be used to perform result handling for the processes.

Documentation

In this field, you can provide the documentation of a process.
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11. SAP IDM — Identity Store Forms

Identity store forms are used to maintain entries in identity store such as privilege, user,
roles, etc. A set of forms are default delivered as package in provisioning framework. An
identity form usually contains below fields:

e Attribute definitions
e Access control
e UI configuration details
Usually forms are defined as public objects inside a package however you can remove

them from public and read them. There are other guided activities apart from default form
as given below:

View Assignment Request Forms

These forms can be used to check the status of assignment requests and can be used to
authorize user to restart any failed activity.

Assignment Request Form

This is used to provide one or more assignment to a user and usually use for providing
context-based roles.

Password Reset

This is used to provide user with guided activity to reset the passwords.

= SAP Identity Management Developer Studio - Eclipse
File Tools Edt Mavigate Search Project Run  Window Help

L= X @ Q- oA A - | | By | & ava [ 1 saP 1M Develo

v =

S4P Identity Management = 0 [ Self Service: Assign Privilege 3

@ Root General | Result Handling |Parameters |A:cess Contral| Presentation Documentation|
= IDM_SQLServer
=& Management
=& Enterprise People Access Type I\l'dx: | COn Behalf of | alue: I
= & Identity Stare Schema ‘Logged-in user of identity store entry Al users  User or identity store entry  All users (self service) ©
= [ packages
= g com,sap, NewPackage 1
Mg Job Log
[+ Repositary Types
o F Seripts
: --SF Constanks
{29 Pracesses
E@ Forms
[ self Service: Assign Friviege

" b Jobs
+ 0 IDM_Oracle
= IC3 1DM_DB2

To create a form, navigate to Forms folder in the package using Identity Management
developer studio > New.

Next is to take action as per below form options:
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If you want to create a Form folder, Select Folder option.
Or to create a form -> Select Form.

Or to create a guided task form - Select Assignment Request/ View Assignment
Request/Password Reset form.

You can also configure the form properties, following tabs are available and after making
changes, navigate to File -> Save.

e General

e Result Handling
e Attributes

e Access Control
e Presentation

¢ Documentation

Dpllnn8| Result handlingl A.lt(ibutesl Access contloli Ples-aiatiml Du-mnenlatiml Orderg
— [v Enabled

Task ID/Name: |1002155/Create Report W Ul task

General - ¥ Fublic tash
Bl boe; IDrdEFEd Lokl :l [T Use inactive entries
Process type: | - Unspecified - 1™ s cortaat wanbine
Repository: I None - L]
Execute task on initialize: | Mone - |
Delay before start: B Minutes =]

[~ ‘Wait for event tasks

Condition

Skip task if audit flag is set. | ~|
General

This tab is used to perform general properties for a form. Below are the options under
General tab:

Field Description

Enabled To enable/disable form

FormID/Name

This shows a number that identifies the form within the Identity Management database.

Form Type
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This is used to define the form type. The following values are available:

e Regular

e Access Control Form

e Display Form

e Search Form
Repository

This option can be used to link the repository to the form. While running the form, selected
repository is used.

Result Handling

This is used to configure the result handling part of the form.

Attributes

This is used to define the form attributes.

Parameters

Parameter is used to configure the guided activity- assignment request/view assignment
request/ password reset.

Access Control

Using this tab, you can define the access part for the form.

Presentation

This is used to configure form presentation.

Documentation

You can provide form description in this tab.
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12. SAP IDM — Maintaining Jobs

In SAP IDM, jobs are stored inside Job folder under package and are executed inside an
identity store. Following actions can be performed:

e Creating a new job
e Enable/Disable an existing job
e Executing a job

To create a new Job, select Job Folder of the package and select New - Job. You can pass
the Job name, connect to a dispatcher and define the Job properties.

] m(U\JTUUP
= &5 Jobs
0@ Initial Load
“® Reset Delta

You can also define the Job properties. To define the Job properties -> Select the job in
the tree view and click on Properties option from context menu.

4 iy Jobs
i® Import New Roles from SA™

Open
Get GUID
Close Related Objects
Close All Other Objects
B Run
Stop
Copy Ctrl+C
. Delete Delete
[4% Refresh F5
Rename
Job Log
‘D Properties H

Below options are available:

e General
e Logging
e State

¢ Documentation

|Generalx ' Logging| Staté] Documnentation

To save the changes to a Job, go to File > Save.
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Below options are available to define Job Properties under General tab:

Enabled: This check box can be used to enable/disable the job.
Job ID/Name: This shows the unique ID and job name.
Schedule Rule: The schedule rule is used to define job execution frequency.

Schedule Time: The schedule time displays the time when the job is scheduled to run.
You can also select "Run to schedule the job” to be run immediately. The scheduled time

is set to the current time.

i@ *Import New Roles from S&P - Properties £3

General Logging | State | Documentation
[¥] Enabled
Job ID/Name: [ 503/Import New Roles from S&P
Scheduling
Schedule Rule: Midnight v
Scheduled Time: Run ’ Stop
Dispatcher

Run by Dispatcher(s): | [ Idm8disp_1

[ ] Bootstrap Job
[ 1Right Trim Source Attributes

To stop a running job, you can click on “Stop” button.

Run by Dispatcher(s): You can choose the dispatcher(s) that are allowed to run this job.
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13. SAP IDM — Self Service Password Reset

In SAP IdM 8.0 or upper version, you can configure Logon help service or self-service
password reset for end users. With login help service, end users can change their
password. To configure Self-service password reset, below prechecks should be met:

e You should have minimum one dispatcher running in landscape.

e There should be one user account exists apart from administrator.

e There should be an Identity Management User Interface configured.

e There should be UME role with action “idm_anonymous” assigned Anonymous

Users groups in UME.

Next step is to create password reset form for end users and to add to identity store
configuration.
Follow the steps to create password reset form:

Go to SAP IdM developer studio >Navigate to package where you want to create the form
for self-service password reset -> Form.

= SAP Identity Management Developer Studio - Eclipse

File Tools Edit Mavigate Search Project Run  Window Help

- I0NE TN FHQUISEDAISIE " o, PRI PR e
SAF'IdentityManagement = 0
= (_i’ Roak
=183 oM

l'l_-] S Management
=W SAP Netweaver Identity Management 8.0
& & Identity Store Schema
[=-(*# Packages
= ﬁ@ com,bestrun, NewPackage1
| E_'I_'l Job Log
[+ Repository Types
o % Scripts
‘ &F Constants
Lﬁ Processes
o

-4 Jobs ) Search...

Go to Context menu - New > Password reset. You can rename the form to PasswordReset
form.

37

@ tutorialspoint

EIMPLYEAGSY LEARMNING



SAP Identity Management

SAP Identity Management = B8
=-@& Root
=3 oM

£3] ,,g Management
EI W SAP MetWeaver Identity Management 8.0
#- & Identity Store Schema
= packages
= ghgi com.bestrun.MewPackagel
: El_'l_‘l Job Log
[+ Repository Types
b & Scripts
EF Constants
@ Processes
13 Forms

&3 Jobs < search... |
g com.sap.i

& com.=2p-! J (% Folder
#8 com.sap.i —
&g com.sap.i " =| Copy Ctr+c LU=/ Form
Eé:} com.sap.i 3¢ Delete Delete ||=| Assignment Request
g com.sap.i - =

- Paske Chrl+Y =1 i .

EEG‘ com.sap. E—— || = View &ssignment Reguest

jord Reset

# com.sap.i
e

Next is to assign Anonymous user group to allows access. For this go to “Access Control”
tab of the newly created form > Select Anonymous in Allow access drop down - OK.

To save the changes, go to File > Save.

= SAP Identity Management Developer Studio - Eclipse

File Run Window Help

PQUEIE e e e e

M =] E

Tools Edk MNavigate Search Project

@

= ‘R 2

J H ‘ %J Java | [ S4P Identity Management Developer Studio

ESAP Identity Management = a = PasswordReset 53

v a g

=@ Root
= oM
& ,9 Management
=] 54P NetWeaver Identity Management 8.0
& 3 Identity Store Schema
= [(# Packages
B ﬁ com.bestrun. MewPackage1
B3y 10b Log
- [+ Repository Types
Ay Scripts
3‘_ Constants
. .2‘ Processes
| = .5 Forms
! =3 PasswordReset
# g3 Jobs

c3] ﬂﬁ'-‘} com.sap.idm.connector. abap € Fiker;
- com.sap.idm,connector. abap.busit ¢ SQL Query,
e} EE:Y com.sap.idm.connector.ad
5] ‘ﬁ} com. sap.idm.connector. asjava —-
® a_j? com. sap.idm.connector. bw i

General Result Handling Parameterslﬂc:ess Cantral Presentation‘Documentation

Access Type | Value | On Behalf of

| Value |

< Access Control [ x}

Chieck Mame |

Referral Attribute: |

Defining Password Reset Parameters

To use self-service password reset, you need to define password reset parameters like

number of questions should prompt, minimum number of correct answers for validation,
etc.

To define the parameters, go to Context menu of the Password reset form - Properties.
Navigate to Parameters tab and configure the parameters as required.
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™ PasswordReset §2 S
General ‘ Result Handling IPlrlmeter: | Access Control l Presentation l Documentation
Entry type: | 6/MX_PERSON

—Account Validation
Min. no of Validation Answers: | 5

~ Identify ~ Set Password
Description: | TASK_PASSWORDRESET_STEP1 .. | | | Description: | #MX_PWDRCY_STEP3
Identification Attribute: | MSKEYVALUE = Password Creation Method: [ Ask the User =
Alternative Identification Attr: | ;I [V Save the Password to UME

~ Verify Identity rFinish
Description: | ‘ME_TASK_PASSWORDRESET_STEPZ ... I Confirmation Message: | #M¥_PWDRCY_STEP4
No of Questions to Show: | 2 Password Reset Failed Task: | 386/PasswordResetFailed
No of Answers Required: | 2
Maximum no of Attempts: | 3
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14. SAP IDM — Setting Email Notifications

You can use notification package available in SAP provisioning framework to set up the
email notification in SAP Identity Management 8.0. There is package available in Developer
Studio “com.sap.idm.util.notification” that contains the notification package and the
templates to enable the notification.

To configure email notification, you need to pass the value of "NOTIFYEVENT"” package
constant and make this point to notification template. You have below notification event
types available:

NOTIFYEVENT_ASSIGNMENT_COMPLETED: To send notification related to assigning
a privilege

NOTIFYEVENT_ASSIGNMENT_FAILED: To send notification related to failed
assignment

NOTIFYEVENT_ASSIGNMENT_REVOKED: To send notification related to access
removal

NOTIFYEVENT_PASSWORD_CHANGED: To send notification related to password
change

NOTIFYEVENT_USER_MODIFIED: To send notification related to modifying user
account

NOTIFYEVENT_USERACCOUNT_CREATED: To send notification related to user account
NOTIFYEVENT_USERACCOUNT_DELETED: To send notification regarding user deletion

NOTIFYEVENT_USERACCOUNT_DISABLED: To send notification related to user
account disablement

NOTIFYEVENT_USERACCOUNT_ENABLED: To enable the user notification

To use this notification events, you need to check out a package in IdM Developer Studio
and create a process.
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=X Identity Store Schema
: 04 Entry Types
w03 atributes
=) # packages
Elﬁ com.bestrun.processes

@'_I Job Log

‘ Repository Types
- % Scripts

- &F Constants
=™ Processes

: Ml dosthProcess

15' Farms

Repository:

Process Type: IReguIar

I -- None --

' *630/doSthProcess/IDM 52

@®

After configuring the notification event types, you need to add the mail template names

in the Notification Package constants.

NOTIFYEVENT_ASSIGNMENT_COMPLETED
NOTIFYEVENT_ASSIGNMENT_FAILED
NOTIFYEVENT_ASSIGNMENT_REVOKED
NOTIFYEVENT_PASSWORD_CHANGED

NOTIFYEVENT_USERACCOUNT _DELETED
NOTIFYEVENT_USERACCOUNT_DISABLED
NOTIFYEVENT_USERACCOUNT_ENABLED
NOTIFYEVENT_USER_MODIFIED

NOTIFYEVENT_USERACCOUNT_CREATED PF Created user notification

The mail template used for completed assignment eve...
The mail template used for assignment failed event.
The mail template used for revoked assignment event.
The mail template used for password changed event.P...
The mail template used for user account created event.
The mail template used for user account deleted event.
The mail template used for user account disabled event.
The mail template used for user account enabled event.
The mail template used for user modified event.
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15. SAP IDM — Connecting SAP ABAP Systems

You can configure your SAP Identity management system to connect to SAP ABAP system
and provision ABAP users. In SAP IdM 8.0 or higher Provisioning framework, you have
connector delivered as separate package with name “com.sap.idm.connector.abap”. This
connector can be used to communicate SAP Identity management system with SAP ABAP
system for user provisioning.

% SAP Identity Management Developer Studio - Eclipse

File Tools Edit Navigate Search Project Run Window Help

i~ X AR Y Pt il v
SAP Identity Management ol = | ## com.sap.idm.connector.sfsf 83
= l.E E’O‘-‘ e ‘General™, Public Objects 1 Dependen(ies] Authorized Users] Re
= DM

Package Options

& & Management

[= W SAP Net\Weaver Identity Management 8,0 ckage l

= & Identity Store Schema B
103 Entry Types

103 Attributes cked [

=1 (## Packages ersion |10

i

3

|

45

kage Name om.sap.idm, connector , sfsf

[+ ﬂ? com, bestrun,NewPackage1
[+ d':” com.bestrun,ralipackage
(23} @ com.sap.idm.connector.abap Last Mo

[+ f’ com,sap.idm.connector. abap. businesssuite Description

AP Package

14-06-11 14:34:43.067

Creating a job for update

In IdM developer studio tree view, you have to select connector package for which you
want to create job. Ex: For ABAP connector package “com.sap.idm.connector.abap”.

Next is to go to Jobs folder, copy the initial job load and rename the Job for ABAP update
in required update, "ABAP- Update”.

Eg Job Log

=% Repository Types
W SFSF
% Scripts
SF Constants
= (% Processes
#- (™ Plugins
& @ Triggers
(™ Forms
. B Jobs
o Initial Load
o™ Reset Dekta ~|

Keep the below pass active and disable the other passes:
e ReadABAPRoles
e ReadABAPProfiles
e ReadABAPCompanyAddress
e ReadJavaRoles
e WriteABAPRolePrivileges: only if corresponding Read pass is active
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e WriteABAPProfilePrivileges: only if corresponding Read pass is active
e WriteABAPCompanyAddress: only if ReadJavaRoles pass is active

e WriteJavaRolePrivileges: only if corresponding ReadJavaRoles pass is active
There are other packages in SAP IdM developer Studio which can be used to connect to

other SAP systems. You have to search for SAP Provisioning Framework packages, choose
IdM files and select the correct file.

For example, to connect to SAP HANA system, you can select the HANA connector package
file "com.sap.idm.connector.hana.idmpck”.

o.\‘) v | = sap = idm = core + ConfigurationPackages = S&P Provisioning Framework - l‘aJ I Search SAP Pravisioning Fram. .. l!
Organize ¥  Mew folder = « [ @
¥ Favorites 21 MName * Date modified I Type | Size I
B Desktop || com.sap.idm.connector.abap.businesssuite.i...  17/06/2015 13:43 IDMPCE File 597 KB
39 Downloads com.sap.idm. connector. abap.idmpck 17/06/2015 13:43  IDMPCK File 960 KB
&l Recent Places com.sap.idm.connector. ad.idmpck 17/06/2015 13:43 IDMPCK File 239 KB
4 Libraries .| com.sap.idm. connector, asjava.idmpck 17/06/2015 13:43 IDMPCK File 542 KB

5 Documents __ com.sap.idm.connector . bw.idmpck 17/06/2015 13:43 IDMPCK File 56 KB

: Music . com.sap.idm.connector.custom.idmpck 17/06/2015 13:43 IDMPCK File 6 KB

=/ Pictures .| com.sap.idm.connector,dualstack.idmpck 17/06/2015 13:43 IDMPCE File 80 KB
E Videos | . com.sap.idm. connector . hana.idmpck IDMPCEK File

8 Computer com.sap.idm.connector.sfsf.idmpck 17J06/2015 13:43 IDMPCK File 204 KB

: ‘:- Local Disk (C:) com,sap.idm.connector,sun.idmpck 17/06/2015 13:43 IDMPCK File 137 KB

. Local Disk (D:) LI . com.sap.idm. provisioning.engine. idmpck 17J06/2015 13:43 IDMPCK File 312KB

File name: Ic-:-m.sap.idm.connector.hana.idmpck j IdM Package Files

| Open I Cancel

Select the required package, and the package will be imported to Identity Management
Developer Studio.

= SAP Identity Management - Eclipse

File Tools Edit MNavigate Search Projeck Run  Window Help

' T : M = |® q v:i g - - - = -
E SAP Identity Management Sl 1
=-@& Root

=-M23 1DM_SqQLServer

[+ ﬁ Management

=B SaP MNetweaver Identity Management .0

[+ 3 Identity Store Schema

Packages
tﬁ} com.sap.idm.connector. abap
t:l:i-} com.sap.idm.connector. abap.businesssuite
#7 com.sap.idm.connector.ad
d}* com.sap.idm.connector, asjava
t‘ﬁ* com.sap.idm.connector ., custom
fﬁi com.sap.idm.connector, dualstack

com.sap.idm.connector . hana
t{}* com.sap.idm.connector, notes
#* com.sap.idm.connector, sfsf
&3{* com.sap.idm.connector, sun

R R R R R FE
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16. SAP IDM — Connecting non-SAP Systems

To connect to non-SAP systems to SAP Identity Management, if default connector package
is not available then you can build you own connector for these commonly used systems
(JDBC, Web Services, flat files, Database, LDAP, etc.).

First step is to setup the Repository and initial load. For setting up the repository you can
use Repository wizard.

Repository wizard - Select a template

. om Select a repository template:
.'_- ol .d-. =<3 C:\usr\sap\IdM\Identity Center\Templates

[»

-~ -
- -4 :: C= =1-“3 Identity Center
{_] EventAgents
{1 3obs
{_ 1 Provisioning
{_ 1 Repositories
£f ADS for SAP PF
$£f Business Suite AS ABAP (Load Balanced Connect
as
£ Directory
£ File
£ Generic repository
£ Notes -
£8 Notification
L4 SAP HANA
£ SAP NetWeaver AS ABAP (Load Balanced Conne
£ SAP NetWeaver AS ABAP (Spedific Application Se
£ SAP NetWeaver AS Java repository (LDAP Backe
£ SAP NetWeaver AS Java repository
£ SAP NetWeaver Dual Stack (Load Balanced Conr
| A @ SAP NetWeaver Dual Stack (Spedific A:laplicatjon =
< »

0-&-&-&

Help | Cancel I <Back | [ Next > | Eirieh |

Below table confirm the list of connectors Provided in SAP Identity Management:
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Dual Stack

AS Java / J2EE Engine applications

Third-party products that support
SPML

AS ABAP applications (SUO1 users),
SAP HCM employee data (export to
SAP Identity Management)

SAP NetWeaver Dual Stack 6.40 and
higher

AS ABAP for SAP Business Suite sys-
tems

SAP Business Suite applications (provi-
sions SUOL users plus application-spe-
cific identity information such as busi-
ness partners)

SAP Enhancement Package 4 for SAP
ERP 6.0

For application-specific dependencies,
see the table below

Microsoft Active Directory

Microsoft Exchange

Microsoft Active Directory

Microsoft Active Directory Versions with
Microsoft Windows Server
2000/2003/2008/2010 Platform: M3
Windows Server
2000/2003/2008/2010

Platform: MS Windows Server
2000/2003/2008/2010

Microsoft Exchange 200772010

SUN One

Any LDAP directory server using the ge-
neric LDAP API

MNovell eDirectory
SunOne Directory

Special requirements for other direc-
tory servers, for example, schema mod-
ifications, on a project base

Platform: Supported platforms for the
respective directory server Novell eDir-
ectory or SunOne Directory: Any re-
lease

SAP HAMNA Connector

SAP HANA Platform Edition

SAP HANA Platform Support Package
Stack 04

Lotus Notes

IBM Lotus Notes

Lotus Domino server version 8.5.3
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17. SAP IDM — Identity Reporting using SAP BW

You can also use SAP Business Warehouse system fo reporting purpose. To use BW for
reporting, you should setup the connectivity between SAP IDM and BW. Post that you need
to transfer identity store data to BW. To connect SAP BW, you can use SAP package
available in IdM developer Studio.

Below software components will be required while using SAP BW for reporting purpose:

e Identity Center
e Virtual Directory Server (VDS)
e SAP NetWeaver BW

e Web service on the BW system

To start with the data transfer, you need to create a job in the Identity Center that triggers
a Web service call from the Virtual Directory Service to the Persistent Staging Area on the
BW system.

You can have multiple call configured depends on the amount of data to be transferred.
This is used for both, i.e., initial load of the data and to perform the subsequent delta
loads.

T2 IDM to BW Data Transfer - [BW]
Bl System log
B Job log
(3 Scripts
D3 lob variables
D3 lob constants
@& Prepare delta criteria
T Transfer current attributes
T Transfer current links
Tm Transfer historical attributes & links
K. End of transmission
@& Update delta criteria for next run
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18. SAP IDM — Integration using GRC 10.0

You can integrate SAP Identity management system with Access control GRC by enabling
set of processes in Identity center. With use of SAP IdM system, you can perform
Provisioning in multiple connected systems based on compliance rules defined in Access
Control. Based on communication defined between Identity management and Access
Control, you can trigger below calls for implementing role synchronization.

¢ RFC Communication

e Web Service Communication

To import GRC Provisioning framework to Identity Center, you can use the separate
package “com.sap.idm.grc.grcl0” in SAP Identity Management 8.0 version. This
package provides the repository type, initial provisioning processes, jobs, and scripts to
perform the initial load.

This package com.sap.idm.grc.grcl0 provides the set of internal and public processes.
Below shows the list of public processes:

- E AC_Vvalidation_Modify

M AC_Validation_Add

- E AC_Validation_Delete

----- B AC_validation_Risk_analysis_Only_Delete
I AC_Validation_Risk_analysis_Only_Add
[ AC_Validation_Risk_analysis_Only_Modify

Following screenshot shows the package structure for integrating GRC Access control to
Identity Management:
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= ﬁ* com.sap.idm.arc.grcl0
. B3 10b Log
=4 Repository Types
- GRCI0
% Scripts
: 3F Constants
=™ GRC 10.0 Provisioning Framework
= t? Core
- AC validation
0 AC Polling
M AC Callback Service
: X AC Validation - Risk Analysis Only
=% Utility tasks
~H Group Failed
M AC Poling Task Failed
. ) Reassign System Privileges (if needed)
- Await validation
- AC_Validation_Modify
- AC_Validation_add
[l AC_Validation_Delete
----- 1 AC_validation_Risk_analysis_Only_Delete
B AC_validation_Risk_analysis_Only_aAdd
i M AC_validation_Risk_analysis_Only_Madify
= (™ Forms
; EJL? GRC Integration Forms
=3 GRC Integration Form
=53 Jobs
@ AC 10,0 - Initial Load - Centralized provisioning
- AC 10,0 - Initial Load - Commons
1® AC 10,0 - Initial Load - Distributed provisioning
Lﬁ' Initial Load - Business Roles
1® Reset Delta - Business Roles
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19. SAP IDM — Migration to New Version

You can also upgrade SAP Identity Management 7.1/7.2 to version 8.0. If you are running
with SAP IdM v7.1 then to upgrade to version 8.0, you need to first upgrade to SAP IdM
v7.2. To migrate to SAP identity management 8.0, your current system should be running
on v7.2 SP09 or v7.2 SP10.

SAP Identity Management v8.0 has some critical improvements from older versions:

e Option to use IDM Developer Studio as Eclipse plug-in
e Ease of integration with other SAP systems

e Better security and access controls

Below checks should be performed before starting the upgrade:

e All dispatchers should be stopped.
e REST API and user interface should be stopped.
e Backup of database and identity data should be taken.

e To upgrade SAP IdM database, you should use mxmc_update script.

You can perform the installation of SAP Idm 8.0 version separately and post installation,
you need to copy key.ini file from 7.2 system to mentioned path:

e Use this location on DB node-
/usr/sap/<SID>/SYS/global/security/data/Key/Keys.ini

e Use this location on runtime environment-
Jusr/sap/<SAPSID>/IDM<Instance_Number>/Identity_Center/Key/Keys.ini

e You should set Keys.ini file referred to this path-
\\<host>\sapmnt\<SAPSID>\SYS\global\security\data\Key\Keys.ini, where
<SAPSID> is the SAP system ID of SAP Identity Management system

e Nextis to perform the Import of identity store from SAP IdM v7.2
e Next is to perform the Import of repositories from SAP IdM v7.2
e Nextis to perform the Import job folders from SAP IdM v7.2

e Next is to perform the Import data from SAP IdM v7.2
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20. SAP IdM — Job Responsibilities

Key responsibilities of SAP IdM Administrator are as follows:

With minimum 3-6 years of experience in SAP IdM

Experience in connecting IdM to SAP and non-SAP systems, AD system and
Database

Ability to handle business role-based assignments

Setting and monitoring the IdM jobs

Good understanding and experience in SAP Security and authorizations
Experience in performing SAP IdM tasks- user management, business and
process workflows, managing identity stores

Setting up the repositories for different SAP and non-SAP apps

Knowledge of SAP GRC v10 Access Control and segregation of duties based on
roles including GRC rules

Good understanding on Information Security controls and knowledge of 1ISO27001

controls
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